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Solarium is a Windows application that retrieves presets from the Solaris over MIDI and displays the 

arrangement of modules graphically. It also works as an editor to some extent, which will hopefully 

improve as the Solaris’s MIDI implementation improves. 

Macintosh computers use the Command key rather than the CTRL key. This guide, for simplicity, refers to 

the CTRL key only but it should be understood that this means the Command key in the case of the 

Macintosh. Also, keypresses do not distinguish by case. For example, “CTRL+M” means the same as 

“CTRL+m” which means hold the control key and press the “m” key. Don’t hold Shift unless the 

command specifically indicates “CTRL+Shift+M”. 

Quick Start 
 

Here’s how to get going right away to retrieve a preset from the Solaris.  

1. Connect your Solaris to the computer by MIDI, both input and output. Then run the Solarium 

application. 

 

2. From the MIDI menu, select Setup. 
    - Or press CTRL+D 
 

 
 

 

3. In the MIDI Setup dialog, select the MIDI input and MIDI output ports and then click Ok. 

 

 
 

 



4. From the MIDI menu, select Receive Preset.  
    - Or press CTRL+R 

    - Or press the Recv button in the lower left corner 

 

 
 

 

5. Solarium will then start to retrieve the preset from the Solaris and you should see the following 

progress dialog. It takes about 10 seconds to transfer a preset. 

 

 
 

If Solarium cannot communicate with the Solaris you’ll see the following message after a few 

seconds. 

 

 

 
 

Check your MIDI connections and try again. 

 

 

 

 

 

 

 



6. Once the transfer is finished, you should see something like the following. 

 

 
 

 

 

Loading Preset Files 
 

Solaris preset files can be loaded. From the main menu select File and then Open. Currently, you cannot 

save to preset files. 

 

  



The Scene and Elements 
 

The scene is the main section of the window that contains the modules connected by wires. The familiar 

word ‘module’ is commonly used when talking about modular synthesizers. But in Solarium the boxes 

that are connected by wires also represent some things that aren’t really modules, such as aftertouch or 

outputs. So in Solarium these boxes are instead called elements. 

Here are Rotor and Insert FX elements: 

               

 

An element can have up to four sections: title bar, Inputs, Mod (modulation), and Control. The last three 

sections are where connections from other elements are made. The white squares where connections 

are made are called ports. 

Title bar – At the top of the element, this includes the name of the element and optionally the audio 

output port(s) and an audio input port provided there is only one. Elements can be moved around by 

dragging them by the title bar. 

Inputs – The Inputs section will only appear in elements that have more than one audio input. For 

example, the Rotor or Mixer. Otherwise, single input ports appear in the title par on the left, such as in 

the Insert FX element shown above. 

Mod – modulation inputs. The white square on the left is the port for connections. In the middle is a 

slider to control the modulation amount. On the right is the destination of the modulation. If there is 

more than one possible destination you can choose the destination from a combo box. 

Control – control inputs. The white square on the left is the port for connections. In the middle is a slider 

to control the strength amount. The name to the right of the slider describes what is being controlled. 

(Note that this is not the destination of the modulation but rather the destination of the control.) 

 



You’ll notice that there is one element called VCA Master that is not evident when programming 

the Solaris from the front panel. But it does exist conceptually. It’s convenient to have this element so 

that you can better see the structure of a preset. For example, envelope generator 6 is tied to it. And the 

four VCAs have to be mixed somewhere! 

 

Compressing Element Sections 
Each section can individually be compressed by clicking on the arrow icon in the gray bar for each 

section. To be compressed means that the rows with no connection are hidden to reduce the visual 

complexity.  Click the arrow again to expand the section. All sections of all elements in the scene can be 

compressed or expanded at once by selecting Compress All (CTRL+C) or Expand All (CTRL+C) from the 

Edit menu. 

Selecting Elements and Element Parameters 
In the scene, the only aspect of elements shown are the connections to each other as well as the 

amount levels and destinations. This is to keep the scene visually simple. To see the remaining 

parameters, left click on an element. The element will become selected as indicated by a red border. 

The parameters for the selected element are shown in the parameter panel to the right of the scene. 

You can select multiple elements by holding down the control key while dragging the mouse to include 

the elements you want to select. All selected elements will have a red border. But in this case, 

parameter panel on the right doesn’t show parameters but rather a list of the selected elements. 

Selecting multiple elements is useful for deleting multiple elements at once 

To de-select all elements, click anywhere on the scene background. When no elements are selected, the 

parameter panel shows global parameters in the Solaris Home pages. 

Scrolling and Zooming 
The scene can be scrolled using the scroll bars at the edges. You can also scroll by clicking on the 

background and dragging. The mouse cursor will then change to the shape of a hand. 

You can zoom the scene in and out using the zoom slider at the bottom of the parameter panel on the 

lower right. By clicking on the slider’s edit box you can enter specific zoom values. The zoom level is 

saved when the application closes. 

Slider Controls 
Many parameters are controlled by sliders. When you click and drag a slider with the mouse you adjust 

the value in coarse increments by default. But holding down the CTRL key while dragging will allow for 

fine adjustment. Also notice that sliders have acceleration---the faster you move the mouse the greater 

the change in the value.  

You can also adjust a slider by hovering over it and using the mouse wheel. You can get fine adjustments 

in one-step increments by holding CTRL. 

You can enter values directly in a slider by double-clicking. (Or by CTRL/Cmd-click, configurable in the 

preferences dialog.) This opens an edit box where you can enter a specific value. 



You can reset a slider to zero by holding CTRL/Cmd key and clicking. (Or by double-click, configurable in 

the preferences dialog.) 

 

Making it Easier to Understand Presets 

Enabling Parts 

You’ve no doubt noticed that when you receive a preset from the Solaris, not all of the elements in the 

Solaris are shown in a scene. To make a preset more understandable, only those elements are shown 

that contribute to the sound. That is, elements are only shown if they have a path through an enabled 

part to an output. This means that you can click on the Enable Part buttons to disable parts and 

temporarily remove the entire chain of elements for that part. This makes it easier to see which 

elements contribute to a part. But you can always add an element manually if you want (explained 

later). 

Wire Colors 

Connecting wires have different colors. Green wires are for audio while black wires are for modulation 

and control. And as you may have already noticed, when you select an element, all wires connected to 

that element turn red. This makes it easier to see where the wires are going in the more complex 

presets. 

Presets can be very complex with wires crisscrossing like spaghetti. To better see the elements behind 

the wires you can adjust the opacity of the wires using the slider in the lower right corner. See the 

Editing section for more on this. 

Layout 

I originally developed Solarium to allow users to place elements anywhere in the scene when building 

presets. But when retrieving a preset from the Solaris, elements have to be put somewhere. So elements 

are automatically laid out in rows and columns. You can move elements around by dragging them by the 

title bar, which can be useful in complex presets to see how wire are connected. But they will often be 

snapped back into place if parameters are changed. 

 

  



Editing 
 

***Editing is currently very limited and only partially supported. Future versions may work better once 

the Solaris NRPN and SysEx are complete. *** 

Adding and Removing Elements 
New elements can be added to the scene by right-clicking on the background. A context menu will 

appear from which you can select elements to add. Adding an element doesn’t change anything in the 

preset or the Solaris. It only makes an element visible. If you manually add an element to the scene in 

this way, it will not be removed—such as by disabling a part—until you manually remove it or retrieve a 

new preset.  

When an element is added, all its source elements, i.e. child elements, are added as well. In turn all of 

those element’s children are added until the entire contributing tree has been added. However, child 

elements added in this way are considered ephemeral. That is, they will be automatically removed if 

their parent is removed. (Note: you’ll get the same effect if MIDI sync is turned on and you adjust the 

parent’s source parameter on the Solaris to switch to another source.) 

There are multiple ways to remove an element. You can click on it to select it and the press the delete 

key. You can click on it to select it and then choose Remove Selected from the Edit menu. Or, you can 

right-click on an element and choose Remove from the context menu. When an element is removed all 

of its connecting wires are also removed. If the element’s output was connected to the input of some 

other element, i.e. its parent element, the parent element’s relevant input parameter is changed to OFF. 

However, no parameters of the removed element itself are changed. 

There are some elements that cannot be removed. This is either because it’s a necessary part of the 

preset or because not all of its output connections can be removed. For example, the VCA Master and 

EG6 cannot be removed. Also, a Filter or InsertFX element cannot be removed if its output is connected 

to a VCA. This is because the VCA input has no OFF setting. So the wire connecting the two cannot be 

removed, only changed to a different source. Multiple element selections cannot be removed if any of 

the elements selected cannot be removed. 

 

Making Connections 
 

You can connect the output of one element to an input of another element (or often the same 

element!) by dragging and dropping. It doesn’t matter which end you start at. First, left click on one 

port: 

 



 

 

Then start dragging. As you drag, some ports change color to yellow. The yellow ports are the valid ports 

that you can connect the other end to. 

 

 

Move the mouse over the destination port. The destination port will turn green when it’s OK to drop the 

other end. 

 



 
 

If an input you want to connect to is already connected, you don’t need to remove the existing wire first. 

Just drop onto the port and the existing wire will be removed. 

 

Removing Connections 
 

You can delete a wire by left clicking it to select it. The wire becomes highlighted. Then press the delete 

key to delete it. Alternatively you can right click on the wire and select Remove from the context menu. 

 
 



Muting Connections 
You can mute a connecting wire by clicking on it (thus selecting it) and choosing Edit/Toggle Mute from 

the main menu or pressing CTRL+M. Alternatively, you can right-click on the wire and select Toggle 

Mute from the context menu. 

When you mute a connecting wire, the wire changes from a solid line to a dashed line. If MIDI Sync is 

enabled, Solarium will send a message to the Solaris to turn off the input that this wire is connected to.  

If you unmute the wire again, a message is sent to restore the input to the former setting. Muting a wire 

makes it easier hear what the preset would sound like if you disconnected the wire without having to 

actually disconnect/reconnect it. 

Note that muting a wire has no effect unless MIDI sync is enabled. Also, be aware that if you mute one 

or more wires, and then you retrieve the MIDI preset from the Solaris, the wires will no longer be muted 

and those muted inputs will just be off. (Obviously the Solaris itself has no notion of muting 

parameters.) 

You can quickly unmute all wires by selecting Edit/Unmute All from the main menu, or press 

CTRL+Shift+M. Another way is to select Unmute All from the context menu you get by right-clicking on 

the surface area. 

 

Muting Elements 
You can mute elements the same way you mute wires. Select one or more elements and choose 

Edit/Toggle Mute from the main menu or press CTRL+M, or right-click on the element and select Toggle 

Mute from the context menu. 

Muting an element has the effect of muting all the wires coming from its output. In effect it’s just a 

shortcut for muting multiple wires at once. And it’s probably easier than muting a wire in many cases 

since it’s easier to click on an element than a wire. 

 

Wire Opacity/Transparency 
Presets can be very complex with wires crisscrossing like spaghetti. To better see the elements behind 

the wires you can adjust the opacity of the wires using the slider in the lower right corner. At 0% wires 

are completely transparent and at 100% they are completely opaque. When wires reach a certain level 

of transparency, they are no longer selectable. This allows you to more easily select the element that is 

behind the wires. The level at which wires become non-selectable can be set in the user preferences 

dialog (CTRL+P). 

As mentioned earlier, when an element is selected its connecting wires become red. In this state the red 

connecting wires are always selectable no matter where the opacity is currently set. This can make it 

easier to select particular wire—you don’t need to move the slider, select a wire, and then move it back. 

 



Additional Editing Notes 
Some connecting wires cannot be removed. These include the light gray connections to the VCA Master 

element. These are hard wired. Also, connections that go to the inputs to the VCA elements cannot be 

removed but they can be changed. The VCA input must be connected to either a Filter element or 

InsertFX element as on the Solaris. 

Some connecting wires cannot be muted. This is because either the parameter has no “off” setting (such 

as the input to the InsertFX) or there is not yet MIDI support for the associated parameter. 

If you load a preset that includes at least one oscillator, then the Vibrato LFO element will also be shown 

because the Vibrato LFO is always hardwired to the oscillators. However the hardwired connection is 

not shown in the scene. 

 

  



Edit History 
Solarium keeps track of all your previous edits. You can undo edits, redo them, or jump to some place in 

your edit history. You can create branches which let you follow different ideas or experiments and still 

get back to where you were. Finally, you can place up to ten bookmarks to mark your place and quickly 

navigate back to them. 

 

Multiple Undo/Redo 
You can undo the most recent edit to a preset by selecting Edit/Undo from the main menu, or by 

pressing CTRL+Z. You can continue this to undo earlier edits one at a time. You can redo the edit that 

was most recently undone by selecting Edit/Redo or pressing CTRL+Y. Currently Undo/Redo only applies 

to edits that effect preset parameters and adding and removing elements. 

If you would like to completely delete the most recent edit press CTRL+Shift+Z. This is called destructive 

undo. In the edit menu destructive undo is shown as “Undo!” When you destructively undo the most 

recent edit you cannot redo it again. There is a limit to how far back in the history you can go with 

destructive undo due to branching, explained below. 

If you have MIDI Sync enabled, the effects of undo/redo operations will also be sent to the Solaris. 

Likewise, changes made on the front panel of the Solaris can also be undone. Remember, not all 

parameters can be handled because the Solaris MIDI implementation is not yet complete. When it is, 

Solarium will be updated to support it. 

 

Bookmarks 
While you’re editing you may reach a point that you’d like remember and get back to later. For this you 

can set a bookmark. There are ten bookmarks which are numbered 0 through 9. To set a bookmark at 

your current location press CTRL + the number of the bookmark to set. If you have NumLock enabled 

you can also use the numpad keys. To return to the bookmark at any time just hit the number of the 

bookmark. Bookmarks cannot be named. 

You can also set and navigate to bookmarks from the Edit menu. If you’d like to see which bookmarks 

have been set, select GoToBookmark from the Edit menu and you’ll see them listed in the submenu. 

Here, bookmarks are named according to branch name and the version within that branch. Bookmarks 

cannot be manually deleted. But if you set a bookmark that has already been set before, the old setting 

is overwritten. A bookmark will be automatically deleted if the version it refers to is permanently 

removed by destructive undo or by deleting a branch. 

 

Edit History Window 
You can see a list of edits made so far by opening the Edit History window. Select Edit/History from the 

main menu or press CTRL+H.  

 



 

At the top of the window is the current branch name in the combo box along with buttons for renaming 

and deleting the current branch (see Branching). 

Below that is the list of the edits made. The orange line indicates the border between edits that have 

been executed (white text) and edits that have been undone (gray text). You can click on a row and all 

edits will be undone up to that row. You can drag the mouse to move the orange dividing line up and 

down. Dragging above or below the window will also scroll the list. Of course, you can also use the scroll 

bar to scroll the list. When the list has the focus, you can also use the up-arrow and down-arrow keys to 

undo and re-do respectively, and you can use the End key to go to the last edit in a branch. 

The blue line indicates where the current branch diverged from the previous branch. This is called the 

branch point. 

The list consists of the following columns: 

# The version number. 

Action The type of edit that was made. 

Time The time that the edit was made. This is based on a 12-hour clock, so 2:00am is the 

same as 2:00pm. (Do you edit for more than 12 hours?) 

Details More information about the edit. 

BM If a version has a bookmark set there, the bookmark number will be shown in this 

column. You can set more than one bookmark on a version. 

Branch Shows the name of the branches on either side of the blue branch dividing line. 



You can resize the column widths using the mouse. By right-clicking on the column header you can 

choose which columns are visible. The column width and visibility are saved in the preferences file when 

Solarium closes. 

Note that the edit history is not saved when you exit the application. So be careful. (However, this 

capability could be added in a future version. ) 

You can undo a MIDI Retrieve Preset operation. This will restore the previous preset values in the 

editor. But it will not automatically resend those previous values to the Solaris because it would take too 

long with the current Solaris MIDI implementation. 

 

Branching 
As explained earlier, you can navigate to any previous version by pressing CTRL-Z or by clicking on a row 

in the edit history window. If you are not at the latest version and you then make an edit, a new branch 

is automatically created. The new branch is added to the list of branches in the combo box at the top of 

the edit window and you are switched to that branch. That is, it becomes the current branch.  A default 

name is given to the branch which is the time that the branch was created. 

The point at which you made the edit---the point the branch was added---is called the branch point. 

When you are switched to the new branch, all the edits that were after the branch point have 

disappeared from the list. But they’re not gone. They’re still in the original branch. The edit history 

window only shows one branch at a time, which is the current branch. You can choose the current 

branch by selecting it from the combo box. Each time you choose a branch to be the current branch, the 

edit history scrolls to the last version in that branch so you can immediately continue adding edits to the 

end of that branch. 

You can change the name of the current branch by pressing the Rename button to the right of the 

branch combo box. The initial branch is named “Start” but you can change the name of that one as well.  

Branches can deleted. Pressing the Delete button will delete the currently selected branch. This will 

delete all edits as far back as the branch point where it was started. You cannot delete all branches—at 

least one branch must exist. There’s currently no way to clear the entire edit history with one command. 

For now, you would need to delete branches one at a time. 

 

Destructive Undo 
Destructive undo works like regular undo except that it permanently deletes the most recent version. So 

you cannot use redo to get back to it. To do a destructive undo, select “Undo!” from the edit menu or 

press CTRL+Shift+Z. You can only destructively undo the last version in a branch. 

You cannot destructively undo edits above the branch point, that is, the point you started that branch 

which is indicated by the blue line in the Edit History window. This is because those edits are also part of 

some other branch. If you have removed all edits in the current branch, the branch itself is not 

automatically deleted. Instead you must manually delete it using the Delete button. (Or you can 

continue to add more edits to that branch.) 



If you destructively undo an edit to which a bookmark refers, that bookmark is automatically cleared. 

Destructive undo (Undo!) is useful to avoid creating branches you didn’t want. If you edit a 

parameter and you decide you don’t want that change at all, use “Undo!” to remove it rather than the 

regular CTRL-z undo. If you were to just do a regular undo and then continue editing, a new branch 

would be added and it’s probably not what you wanted. 

 

 

 

  



Arpeggiator Editor 
The arpeggiator parameters can be edited in a separate window that can be opened by selecting 

Edit/Arp Editor from the main menu or by pressing CTRL+e.  (CTRL+e also closes it.) 

 

 

Across the top are the general arpeggiator settings. These are the same parameters seen in the Arp page 

on the Solaris. 

Below that are the 32 arpeggiator steps. For each step there are three parameters that can be edited. 

- The step volume can be edited using the vertical slider. 

- The length of the step can be edited by the smaller horizontal slider below the volume slider. 

- The “gate”, or the step enable, can be toggled on or off by the green button at the bottom. 

You can reset all settings, step volumes, step lengths, or step gates from the Reset menu.   

These step parameters cannot be edited by using the Solaris front panel so an external editor is 

currently the only way to define them. 

        The entire Arp Editor window can be resized by dragging an edge or a corner.  

 

Opening and Saving Pattern Files 
You can load and save the step settings from and to a pattern file (.pat) from the File menu. The pattern 

file that Solarium saves to is the same type of pattern file that the Solaris uses. So you can save a pattern 

to the CF card, plug the card into the Solaris, and load the pattern using the Solaris Pattern parameter. 



Note that the only values saved to the pattern file are the 32 step values including volume, length and 

gate (enable). No other arpeggiator settings are saved to the pattern file. Actually, the arpeggiator 

editor does save the number of steps, i.e. the pattern length, but the Solaris will not recognize this if you 

load the pattern file into to Solaris from the CF card. It’s only recognized by the Arp Editor. Therefore, 

the best way to edit the arpeggiator is probably to edit with sync enable so that changes are sent over 

MIDI, then when done, save the preset from the Solaris so the arpeggiator settings are saved in the 

preset. 

 

  



MIDI 
 

In the lower left of the main windows are three buttons related to MIDI. 

 

 

As already seen in the Quick Start section earlier, you can retrieve the current settings in the Solaris by 

pressing the Recv button. This takes about 10 seconds. 

The Send button will send the current settings to the Solaris. This includes all parameters, not just the 

parameters for the elements that are visible. However, I don’t currently recommend using the Send 

button for now. Some parameters are not supported anyway and Solaris doesn’t necessarily respond 

correctly. You might inadvertently change parameters on the Solaris in a way you don’t want. 

Furthermore, Send takes a long time, longer than Receive. This is because there isn’t a way to know the 

fastest speed that the Solaris can receive data and it appears it cannot handle full speed. I’ve done some 

trial-and-error to find a conservative speed at which that the Solaris can accept data accurately. 

The Sync button will toggle the sync function. When sync is ON (the blue LED is lit) most changes made 

on the Solaris will be reflected on the editor and most changes made in the editor will be sent to the 

Solaris. Since the Solaris NRPN/SysEx implementation is not yet complete, many parameters cannot be 

synced. Also, the Solaris does not currently generate MIDI messages when its parameters are changed 

via buttons or the dial. So the only changes that the editor can follow are those made using the 

encoders. 

** Note that when the Solaris sends out NRPN messages, it only sends the NRPN index each time a new 

encoder is moved. Otherwise it sends just the value. This means that if you move an encoder, then start 

up the Solarium application and then move the same encoder again, Solarium will only receive the NRPN 

value and not the index. It won’t know which encoder was moved and so will not show the change even 

when Sync is enabled. You’ll need to move a different encoder to get the Solaris to transmit a new 

index. 

  



Preferences File 
On Windows, the user preferences are maintained in a file with path: 

    C:\Users\<username>\AppData\Roaming\Solarium\Solarium.config 

This file also contains such things as window locations and dimensions that are remembered. 

If you need to restore your settings to the defaults, you can first close Solarium and then delete this file 

(or just rename it to something else, or move it to a different folder). Alternatively, since this is a text 

file, you can edit it with a text editor and just remove the lines that correspond to the settings you want 

to reset. 

 

Main Unsupported Capabilities 
Solarium is an unfinished program and there are many missing functions. Below are a few of the biggest 

ones. Part of the reason for this is that the Solaris MIDI support is not fully implemented yet. 

1. All parameters that represent a time value ranging from 0 to 20 seconds cannot get values from 

the Solaris via MIDI (but preset files work). The main examples are the ADSR values. The Solaris 

does not currently support this. 

2. All parameters that represent a frequency value ranging from 0 to 20 KHz cannot get values 

from the Solaris via MIDI (but preset files work). Examples are the frequency values of the EQ 

effect. 

3. The Solaris does not report the FX channel info or which slot effects are in. So Solarium assumes 

that all effects are in one FX Channel. The effects may not be in the correct slots but they should 

be in the correct order. 

4. These are some of the parameters that Solaris does not support over MIDI and thus cannot be 

controlled:  Transpose, Delay MIDI Clock, Preset Name, FX Channels, Playmode, Univoice, 

unitune, note priority, BPM. None of the output settings except Output 1/2. Nothing on Page2/4 

of Home. 

5. Sequencer steps for sequencers B, C, and D on the Solaris cannot be set to negative values using 
SysEx. 

6. There is no MIDI support for Key Table values. 
7. VCA modulation amount 2 (Pan) on the Solaris does not seem to respond to SysEx. 
8. LFO Delay Start on the Solaris does not respond correctly to SysEx. It can only be set in 

increments of 600ms. 

9. If you turn off the Solaris OSC clock sync by SysEx, it turns on No Track even if it wasn't on 

before. There’s no way for the editor to know that. 


